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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Microchip EVB-LAN9255 Evaluation Board. Items discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• The Microchip Website
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT

This document features the EVB-LAN9255 Evaluation Board. The manual layout is as 
follows:

• Chapter 1. “Overview” – This chapter provides a brief description of the 
EVB-LAN9255.

• Chapter 2. “Getting Started” – This chapter provides information on the setup 
and operation of the EVB-LAN9255.

• Chapter 3. “Hardware Configuration” – This chapter includes information on 
the hardware configuration of the EVB-LAN9255.

• Appendix A. “Schematics” – This appendix shows the EVB-LAN9255 sche-
matic diagrams.

• Appendix B. “Bill of Materials” – This appendix includes the EVB-LAN9255 Bill 
of Materials.

• Appendix C. “Silk Screens” – This appendix includes the EVB-LAN9255 silk 
screen images.

• Appendix D. “Slave Stack Code Generation” – This appendix details the proce-
dure for generating SSC for EtherCAT operation on EVB-LAN9255.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can 
be any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Send-
ing the Warranty Registration Card entitles users to receive new product updates. 
Interim software releases are available at the Microchip website.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. Acces-
sible by using your favorite Internet browser, the website contains the following infor-
mation:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions, or errata related to a specified product family or development tool of

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers
and other language tools. These include all MPLABCC compilers; all MPLAB
assemblers (including MPASM™ assembler); all MPLAB linkers (including
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object
librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This
includes the MPLAB® REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 debug
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows®

Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included
are non-production development programmers such as PICSTART® Plus and
PICkit™ 2 and 3.
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 7
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revisions Section/Figure/Entry Correction

DS50003106C 
(07-11-22)

Section Chapter 
3. “Hardware Configu-
ration”

Updated descriptions for Ref. Des. D6-D9 in 
Table 3-2.

Section Appendix 
A. “Schematics”

Updated the schematics diagrams.

Section Appendix 
B. “Bill of Materials”

Updated Table B-1.

Section Appendix 
C. “Silk Screens”

Updated the silk screen images.

DS50003106B 
(05-18-21)

Section 2.2 “Kit Con-
tents”

Removed Type A USB cable and included the 
requirement for a micro-B USB cable in the note

Figure 3-1 Replaced with an updated figure

Figure A-1 to 
Figure A-3

Replaced with updated schematics

Table B-1 Replaced with an updated Bill of Materials

Figure C-1 and 
Figure C-2

Replaced with updated silk screens

DS50003106A 
(01-19-21)

Initial release
DS50003106C-page 8  2021-2022 Microchip Technology Inc. and its subsidiaries

http://www.microchip.com/support
http://www.microchip.com/support


EVB-LAN9255
EVALUATION BOARD
USER’S GUIDE

Chapter 1.  Overview
1.1 INTRODUCTION

The EVB-LAN9255 Evaluation Board is used to evaluate the LAN9255 device, which
integrates a LAN9253 EtherCAT® device controller with a SAM E53J ARM MCU. The
LAN9253 is an EtherCAT device with dual integrated Ethernet PHYs. Each Ethernet
PHY contains a Full-Duplex 100BASE-TX transceiver and supports 100 Mbps
(100BASE-TX) operation.

The EVB-LAN9255 allows users to gain understanding of the product and accelerate
integration of the LAN9255 into their design. The evaluation platform supports two 
EtherCAT ports, and the SAM E53 processor that is integrated into the LAN9255
enables the configuration of the evaluation board for EtherCAT operation. For more
information about EVB-LAN9255, see Section 1.2 “Features”.

1.2 FEATURES

• Two-port 100BASE-TX Full-Duplex EtherCAT device controller with integrated 
Ethernet PHYs

• LAN9255 in a 128-pin TQFP RoHS-compliant package

• USB Micro-B connector for board power

• mikroBUS™ connector for external peripherals

• MCU RMII connector for optional external Ethernet PHY

• Two RJ-45 ports with LED link/activity indicators

• Atmel-ICE 10 pin-connector

• PICkit™ 4 8-pin header for SAM E53 programming

1.3 BLOCK DIAGRAM

FIGURE 1-1: EVB-LAN9255 BLOCK DIAGRAM
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1.4 REFERENCES

Concepts and materials available in the following documents may be helpful when 
reading this document. Visit www.microchip.com for the latest documentation.

• LAN9255 Data Sheet (www.microchip.com/DS00003646)

• LAN9253 Data Sheet (www.microchip.com/DS00003421)

• SAM D5X/E5X Family Silicon Errata and Data Sheet Clarification 
(www.microchip.com/DS80000748)

• MPLAB® PICkit™ 4 In-Circuit Debugger User’s Guide 
(www.microchip.com/DS50002751)

1.5 TERMS AND ABBREVIATIONS

The following are the terms and abbreviations used in this document:

• DNP – Do Not Populate

• EEPROM – Electrically Erasable Programmable Read-Only Memory

• EVB – Engineering Validation Board

• EtherCAT – Ethernet for Control Automation Technology

• IDE – Integrated Development Environment

• LOS – Loss of Signal

• MCU – Microcontroller Unit

• RJ-45 – Ethernet Port

• RMII – Reduce Media Independent Interface

• SD – Signal Detect

• SPI – Serial Protocol Interface

• SSC – Slave Stack Code

• TwinCAT – EtherCAT Runtime System Tool

• USB – Universal Serial Bus
DS50003106C-page 10  2021-2022 Microchip Technology Inc. and its subsidiaries
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Chapter 2.  Getting Started
2.1 INTRODUCTION

The Microchip EVB-LAN9255 Evaluation Board is designed for flexible configuration 
solutions. It can be configured via MPLAB® Harmony, TwinCAT, and Slave Stack Cod-
ing tools. Refer to Section 2.3 “Tools for EVB-LAN9255 Setup Procedure” for the nec-
essary tools to configure the board for EtherCAT functionality.

2.2 KIT CONTENTS

The EVB-LAN9255 Evaluation Board includes the basic equipment necessary for eval-
uation. An essential item in the kit is the EVB-LAN9255 Evaluation Board.

2.3 TOOLS FOR EVB-LAN9255 SETUP PROCEDURE

These are the software and tools necessary for setting up the control or management 
PC and programming the EVB-LAN9255 Evaluation Board:

• Beckhoff TwinCAT Software

• Microchip MPLAB® X IDE (v5.30 or newer)

• Microchip XC32 Compiler

• Microchip PICKit 4 In-Circuit Debugger

• Microchip Harmony Plug-In (through MPLAB X IDE)

• EtherCAT Slave Stack Code (refer to Appendix D. “Slave Stack Code Genera-
tion”)

• GitHub MPLAB Harmony v3 EtherCAT repository, which provides detailed infor-
mation on creating an EtherCAT application using Harmony

On the board, the following jumpers are required:

• J6, positions 1-2 (EESCL to EEPROM and header)

• J11 (power)

• J17, positions 1-2 (EMUL0 = 0)

• J17, positions 4-5 (EMUL0 = 0)

• J17, positions 7-8 (EMUL1 = 0)

• J17, positions 11-12 (EMUL2 = 1)

Note: The EVB-LAN9255 Evaluation Board requires a PICKit™ 4 In-Circuit 
Debugger as additional hardware for the configuration of the integrated 
SAM E53 MCU. A micro-B USB cable is also needed to power the board.
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 11
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Chapter 3.  Hardware Configuration
3.1 HARDWARE CONFIGURATION OPTIONS

Figure 3-1 shows the top view of the EVB-LAN9255 Evaluation Board.

FIGURE 3-1: EVB-LAN9255 EVALUATION BOARD (TOP VIEW)

3.1.1 Power

The EVB-LAN9255 is powered using a USB cable. Jumper J11 must be installed.

Alternatively, remove the J11 jumper and apply 5V (1A) to pin 1 of header J11.

The 5V indicator is LED D4, while the 3.3V voltage regulator output indicator is LED D5.

A standard USB 500 mA 5V supply is adequate for the EVB-LAN9255 without 
mikroBUS™ or Ethernet RMII daughter boards. A 500 mA supply is usually adequate 
for a single daughter board if the daughter board draws no more than 250 mA, since 
the EVB-LAN9255 by itself draws approximately 250 mA. If daughter boards are 
installed in both the mikroBUS and Ethernet RMII sockets, then a 1A USB supply is rec-
ommended.

3.1.2 mikroBUS™

The EVB-LAN9255 has a socket for a mikroBUS add-on board. This allows for LCD dis-
plays, motor control, and other click-board interfaces. To enable a mikroBUS board, 
some settings must be configured with the MCU.

3.1.3 Ethernet RMII

The EVB-LAN9255 has a socket for a Microchip RMII-connected expansion board con-
taining an Ethernet PHY or switch. This socket connects to an Ethernet MAC on the 
SAM E53 MCU, and the management is via an MDC/MDIO interface. The RMII 50 MHz 
clock is generated on-board the EVB-LAN9255.

Examples of compatible daughter boards available from Microchip are the LAN9303 
Switch Daughter Board (AC320004-4), LAN8720 PHY Daughter Board (AC320004-3), 
KSZ8041 PHY Daughter Board (AC320004-5), KSZ8061 PHY Daughter Board 
(AC320004-6), and KSZ8863 Switch Daughter Board (AC320004-7).
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 13
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3.1.4 Clocks

The EVB-LAN9255 Evaluation Board has the following clocks:

• A 25 MHz reference crystal for EVB-LAN9255 (also has an option for 25 MHz 
oscillator). The LAN9253 outputs 25 MHz as the reference clock to the SAM E53.

• A 32.768 KHz crystal for real-time clock on the SAM E53

• An oscillator generates a 50 MHz clock for the RMII interface.

3.1.5 Ethernet Ports

The EVB-LAN9255 has two 100BASE-TX Ethernet ports for EtherCAT operation, and 
these are J1 (PORT0 IN) and J2 (PORT1 OUT).

3.1.6 EEPROM and EEPROM Emulation

The EVB-LAN9255 has an EEPROM for configuring the LAN9253. The LAN9253 also 
supports EEPROM emulation in which it is configured by the SAM E53 instead of the 
EEPROM. The EE Emulation mode is set by the jumpers in header J17.

Table 3-1 lists the EE Emulation modes as configured by J17.

Note: Two jumpers are required for EE_Emul bit 0. Set both jumpers to the same 
setting, either ‘0’ or ‘1’. Do not mix them.

TABLE 3-1: EE EMULATION MODE CONFIGURATION STRAP VALUES

EE_EMUL [2:0] EEPROM Emulation Mode

000 SPI

001 Not used for EVB-LAN9255

010 Not used for EVB-LAN9255

011 Not used for EVB-LAN9255

100 SPI EtherCAT Direct mode

101 Beckhoff SPI mode

110 EEPROM is enabled.

111 EEPROM is enabled.
DS50003106C-page 14  2021-2022 Microchip Technology Inc. and its subsidiaries



Hardware Configuration
3.1.7 LED Indicators

Table 3-2 describes the LED indicators on the EVB-LAN9255.

3.1.8 Switches

Table 3-3 describes the switch on the EVB-LAN9255.

TABLE 3-2: EVB-LAN9255 LED INDICATOR DESCRIPTIONS

Ref. Des. Label Description

D1 RST LAN Indicates EVB-LAN9255 Reset

D2 RUN Indicates EVB-LAN9255 RUN status from the LAN9253

D3 ERROR
Indicates EVB-LAN9255 ERROR status from the 
LAN9253

D4 5V Illuminates when the 5V supply is present

D5 3V3 Illuminates when the 3.3V supply is present

D6 PB04 SAM E53 pin PB04, active-high

D7 PB05 SAM E53 pin PB05, active-high

D8 PB06 SAM E53 pin PB06, active-high

D9 PB07 SAM E53 pin PB07, active-high

J1
(Green LED)

LINK0 Indicates the link status of Port0

J2
(Green LED)

LINK1 Indicates the link status of Port1

TABLE 3-3: EVB-LAN9255 SWITCH DESCRIPTION

Ref. Des. Label Description

SW1 RESET
Momentary push-button switch to assert Reset to both 
LAN9253 and SAM E53
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 15
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3.1.9 Connector Descriptions

Table 3-4 describes the connectors included on the PCB.

TABLE 3-4: EVB-LAN9255 CONNECTOR DESCRIPTIONS

Ref. Des. Type Label Description

J1
RJ-45 Ethernet 

Port 
PORT0 IN

100BASE-TX Ethernet port for Ether-
CAT ingress traffic

J2
RJ-45 Ethernet 

Port
PORT1 OUT

100BASE-TX Ethernet port for Ether-
net egress traffic

J3 1x5 Header QSPI
QSPI communication header, not pop-
ulated, for debug only

J4 1x3 Header I2C

I2C communication to the I2C 
EEPROM. To enable, J6 must have 
jumper in positions 1 and 2, and J17 
must have all jumpers installed in the 
‘1’ position.

J5 1x8 Header PICKit-4 PICKit™ 4 programming header/port

J6 1x3 Header SCL/TCK
Selects between EEPROM I2C com-
munication (positions 1 and 2) and 
JTAG (positions 2 and 3).

J7 2x5 Header UART

UART header to SAM E53. SAM E53 
calls this Universal Synchronous and 
Asynchronous Receiver and Transmit-
ter (USART).

J8
Micro-USB
Connector

USB
The board receives power via the USB 
connector.

J9 2x8 Header LAN GPIO
Test header for all LAN9253 GPIO sig-
nals (0 to15)

J10 2x5 Header Atmel ICE SAM-ICE™ programming port

J11 1x2 Header 5V

5V voltage supply header. In a closed 
position, VBUS from J8 is used as the 
5V supply. In an open position, external 
5V must be applied to position 1.

J12 1x5 Header JTAG
JTAG port. To enable, install the J6 
jumper in position 2-3.

J13 1x8 Header MCU GPIO SAM E53 input/output test header

J15
Micro Coax 
(UMC) Jack

SYNC0
SYNC0 reference to synchronize 
clocks

J16
Micro Coax 
(UMC) Jack

SYNC1
SYNC1 reference to synchronize 
clocks

J17 3x4 Header
EE_EMUL 

Mode

Configuration straps for EE Emulation 
mode. Both of the EMUL0 jumpers 
must be set to either ‘0’ or ‘1’. Do not 
mix them. Set all jumpers to ‘1’ to 
enable the EEPROM.

J18
mikroBUS™

Connector
MIKROBUS

Socket for optional mikroBUS board. 
Ensure 1A of 5V power when a daugh-
ter board is installed.

J99 Ethernet RMII RMII Socket

Socket for optional Microchip Ethernet 
RMII™ daughter board. Ensure 1A of 
5V power when a daughter board is 
installed.
DS50003106C-page 16  2021-2022 Microchip Technology Inc. and its subsidiaries



Hardware Configuration
3.1.10 Test Points

Table 3-5 describes the test points on the EVB-LAN9255. A header may be perma-
nently installed on the through-hole test points if needed.

TABLE 3-5: EVB-LAN9255 TEST POINT DESCRIPTIONS

Ref. Des. Type Description

TP1
Test Loop 

(White)
IRQ (interrupt request) output from the LAN9253 and the 
SAM E53

TP3 Not Populated This pin not used for this board.

TP4 Test Loop (Red)
1.2V oscillator supply from the LAN9253 internal regula-
tor

TP7 Test Loop (Red) 3.3V supply

TP11
Test Loop 

(White)
LAN9253 WAIT_ACK/PME output

TP2, TP8
Test Loop 

(Black)
Ground
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 17
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EVB-LAN9255
EVALUATION BOARD
USER’S GUIDE

Appendix A. Schematics
A.1 INTRODUCTION

This appendix shows the EVB-LAN9255 Evaluation Board schematics.
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 19
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Appendix B. Bill of Materials
B.1 INTRODUCTION

This appendix contains the EVB-LAN9255 Evaluation Board Bill of Materials (BOM).
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Manufacturer Manufacturer Part Number

GRM155R71C104KA88D

a AVX 04025A100JAT2A

GCM155R71H223KA55D

uden EMK107BBJ106MA-T

a AVX 04025A100JAT2A

C1005X7R1H104K050BB

on 202R18W102KV4E

uden LMK107BJ475KA-T

uden EMK107BJ105KA-T

Lite-On LTST-C191KRKT

Lite-On LTST-C191KGKT

SML-D12Y1WT86

BLM18PG221SN1D

lectronics Network J0011D01BNL

NOL ICC (FCI) 68001-108HLF

nol ICC 68000-103HLF

NOL ICC (FCI) 68001-108HLF

ONNECT USA PR20205VBDN

ome Connectors 10118194-0001LF

NOL ICC (FCI) 68602-116HLF

ch 3220-10-0100-00

mp SPC SPC20481

nol ICC 68000-105HLF

nol RF A-1JB

TSW-104-07-G-T

PPTC081LFBN-RC

LPPB121NFFN-RC

LPPB031NFFN-RC

QPC02SXGN-RC

ft 0805PS-103KLC

 Paper (M) Sdn Bhd 037268-5

SJ61A11
TABLE B-1: EVB-LAN9255 BILL OF MATERIALS

Item Qty References Description Populated

1 33

C1, C2, C13, C15, C16, C17, C18, 
C21, C22, C23, C24, C25, C26, C27, 
C28, C29, C30, C31, C33, C34, C35, 
C36, C37, C38, C44, C45, C46, C47, 
C49, C50, C52, C53, C59

CAP CER 0.1uF 16V 10% X7R SMD 0402 Yes Murata

2 8 C3, C4, C5, C6, C8, C9, C10, C11 CAP CER 10pF 50V 5% NP0 SMD 0402 DNP Kyocer

3 2 C7, C12 CAP CER 0.022uF 50V 10% X7R SMD 0402 Yes Murata

4 6 C14, C40, C41, C48, C58, C63 CAP CER 10uF 16V 20% X5R SMD 0603 Yes Taiyo Y

5 4 C19, C20, C56, C57 CAP CER 10pF 50V 5% NP0 SMD 0402 Yes Kyocer

6 2 C32, C61 CAP CER 0.1uF 50V 10% X7R SMD 0402 DNP TDK

7 2 C39, C62 CAP CER 1000pF 2KV 10% X7R SMD 1206 Yes Johans

8 3 C42, C43, C51 CAP CER 4.7uF 10V 10% X5R SMD 0603 Yes Taiyo Y

9 4 C54, C55, C60, C64 CAP CER 1uF 16V 10% X5R SMD 0603 Yes Taiyo Y

10 2 D1, D3 DIO RED 2V 20mA 54mcd CLEAR SMD 0603 Yes Vishay 

11 3 D2, D4, D5 DIO LED GREEN 2V 30mA 35mcd Clear SMD 0603 Yes Vishay 

12 4 D6, D7, D8, D9 LED YELLOW DIFFUSED 1608 SMD Yes Rohm

13 5 FB1, FB2, FB3, FB4, FB5 FERRITE 220R@100MHz 1.4A SMD 0603 Yes Murata

14 2 J1, J2 CON MODULAR JACK RJ45 100 2xLEDS SHIELD TH R/A Yes Pulse E

15 1 J3 CON HDR-2.54 Male 1x8 Gold 5.84MH TH DNP AMPHE

16 2 J4, J6 CON HDR-2.54 Male 1x3 Gold 5.84MH TH VERT Yes Amphe

17 2 J5, J13 CON HDR-2.54 Male 1x8 Gold 5.84MH TH Yes AMPHE

18 1 J7 CON HDR-2.54 Male 2x5 0.100" (2.54mm) TH VERT Yes METZ C

19 1 J8 CON USB2.0 MICRO-B FEMALE TH/SMD R/A Yes Framat

20 1 J9 CON HDR-2.54 Male 2x8 Gold 5.84MH TH VERT Yes AMPHE

21 1 J10 CON HDR-1.27 Male 2x5 Gold Shroud 5.4MH TH VERT Yes CNC Te

22 1 J11 CON HDR-2.54 Male 1x2 Gold 5.84MH TH VERT Yes Multico

23 1 J12 CON HDR-2.54 Male 1x5 Gold 5.84MH TH VERT Yes Amphe

24 2 J15, J16 CON RF Micro Coaxial U.FL Male 4P SMD VERT Yes Amphe

25 1 J17 CON HDR-2.54 Male 3x4 Gold 5.84MH TH VERT Yes Samtec

26 1 J18 SOCKET mikroBUS HOST DIP 16 TH Yes Sullins

27 2 J99-1, J99-3 CON HDR-1.27 FEMALE 1x12 TH VERT Yes Sullins

28 2 J99-2, J99-4 CON HDR-1.27 FEMALE 1x3 TH VERT Yes Sullins

29 6 JP1, JP2, JP3, JP4, JP5, JP6 MECH HW JUMPER 2.54mm 1x2 MECH Sullins

30 1 L1 INDUCTOR 10uH 430mA 10% SMD 0805 DNP Coilcra

31 1 LABEL1 LABEL PCBA 18x6mm BarCode-AssyID-Rev-Serno MECH Sunrise

32 4 PAD1, PAD2, PAD3, PAD4 MECH HW RUBBER PAD CYLINDRICAL D7.9 H5.3 BLACK MECH 3M
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ctronics RMCF0603FT33R0

CRCW060310K0FKEA

ctronics RMCF0603FT1K00

ctronics RMCF0603FT330R

ctronics RMCF0603FT330R

ERJ-3EKF1212V

CRCW060310K0FKEA

ERJ3EKF49R9V

ctronics RMCF0603ZT0R00

ERJ-3EKF2201V

ctronics RMCF0603ZT0R00

ERJ-2RKF33R0X

RC0603FR-0784K5L

RC0603FR-0712KL

ctronics RMCF0603FT15R0

ctronics RMCF0603FT33R0

TC33X-2-103E

PTS810SJM250SMTRLFS

ctronics 5002

ctronics 5001

ctronics 5002

ctronics 5000

ctronics 5004

LAN9255-I/ZMX020

MCP1826T-ADJE/DC

24FC512T-I/SN

ents MAX3232CDBR

A 74LVC1G14GW,125

VXM7-9013-25M0000000

DSC1001CI2-025.0000T

TA

ufacturer Manufacturer Part Number
33 2 R0, R22o RES TKF 33R 1% 1/10W SMD 0603 DNP Stackpole Ele

34 14
R1, R5, R6, R8, R10, R11, R12, R20, 
R26, R30, R34, R41, R42, R72

RES TKF 10k 1% 1/10W SMD 0603 Yes Vishay

35 9
R2, R27, R29, R40, R43, R65, R66, 
R67, R68

RES TKF 1k 1% 1/10W SMD 0603 Yes Stackpole Ele

36 5 R3, R13, R25, R33, R61 RES TKF 330R 1% 1/10W SMD 0603 Yes Stackpole Ele

37 2 R4, R14 RES TKF 330R 1% 1/10W SMD 0603 DNP Stackpole Ele

38 1 R7 RES TKF 12.1k 1% 1/10W SMD 0603 Yes Panasonic

39 4 R9, R69, R70, R71 RES TKF 10k 1% 1/10W SMD 0603 DNP Vishay

40 8
R15, R46, R47, R48, R50, R51, R52, 
R53

RES TKF 49.9R 1% 1/10W SMD 0603 Yes Panasonic

41 10
R16, R17, R22, R28, R35, R36, R38, 
R49, R54, R62

RES TKF 0R 1/10W SMD 0603 Yes Stackpole Ele

42 3 R18, R19, R37 RES TKF 2.2k 1% 1/10W SMD 0603 Yes Panasonic

43 1 R21 RES TKF 0R 1/10W SMD 0603 DNP Stackpole Ele

44 9
R23, R24, R45, R55, R56, R57, R58, 
R63, R64

RES TKF 33R 1% 1/10W SMD 0402 Yes Panasonic

45 1 R31 RES TKF 84.5k 1% 1/10W SMD 0603 Yes Yageo

46 1 R32 RES TKF 12k 1% 1/10W SMD 0603 Yes Yageo

47 2 R39, R44 RES TKF 15R 1% 1/16W SMD 0603 Yes Stackpole Ele

48 1 R59 RES TKF 33R 1% 1/10W SMD 0603 Yes Stackpole Ele

49 1 R60 RES TRIMMER 10k 25% 0.1W SMD TC33 Yes Bourns

50 1 SW1
SWITCH TACT SPST 16V 50mA PTS810 SJM 250 SMTR LFS 
SMD

Yes ITT C&K

51 2 TP1, TP11 MISC, TEST POINT MULTI PURPOSE MINI WHITE Yes Keystone Ele

52 2 TP2, TP8 MISC, TEST POINT MULTI PURPOSE MINI BLACK Yes Keystone Ele

53 4 TP3, TP6, TP12, TP13 MISC, TEST POINT MULTI PURPOSE MINI WHITE DNP Keystone Ele

54 2 TP4, TP7 MISC, TEST POINT MULTI PURPOSE MINI RED Yes Keystone Ele

55 1 TP5 MISC, TEST POINT PC MINI, 0.040" D YELLOW DNP Keystone Ele

56 1 U1
MCHP INTERFACE ETHERNET LAN9255 EtherCAT Slave 
Controller TQFP128

Yes Microchip

57 1 U2 MCHP ANALOG LDO ADJ MCP1826T-ADJE/DC SOT-223-5 Yes Microchip

58 1 U3
MCHP MEMORY SERIAL EEPROM 512kb 1MHZ I2C 
24FC512T-I/SN SOIC-8

Yes Microchip

59 1 U4 IC TRANSCEIVER MAX3232 SSOP-16 Yes Texas Instrum

60 1 U7 74LVC1G14GW,125 SCHMITT-TRG INVERTER Yes Nexperia US

61 1 Y1 MCHP CRYSTAL 25Mhz 10pF SMD L3.2W2.5H0.8 Yes Microchip

62 1 Y1o
MCHP CLOCK OSCILLATOR SINGLE 25MHZ DSC1001-
CI2-025.0000T CDFN-4

DNP Microchip

BLE B-1: EVB-LAN9255 BILL OF MATERIALS (CONTINUED)
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ip DSC1001CI2-050.0000T

ctronics FK135EIHM0.032768-T3

ip DSC1001CI2-025.0000T

Manufacturer Manufacturer Part Number
63 1 Y2
MCHP CLOCK OSCILLATOR 50MHz DSC1001CI2-050.0000T 
DFN-4

Yes Microch

64 1 Y3 CRYSTAL 32.768KHz 12.5pF SMD L3.2W1.5H0.9 Yes Fox Ele

65 1 Y4
MCHP CLOCK OSCILLATOR SINGLE 16MHZ DSC1001-
CI2-016.0000T CDFN-4

DNP Microch

TABLE B-1: EVB-LAN9255 BILL OF MATERIALS (CONTINUED)

Item Qty References Description Populated
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Appendix C. Silk Screens
C.1 INTRODUCTION

This appendix shows the top and bottom silk screen images of the EVB-LAN9255 Evaluation Board.
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FIG
URE C-2: EVB-LAN9255 BOTTOM SILK SCREEN IMAGE
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Appendix D. Slave Stack Code Generation
D.1 INTRODUCTION

This appendix details the procedure for generating the Slave Stack Code (SSC) for EtherCAT operation on
the EVB-LAN9255 Evaluation Board.

D.2 PROCEDURE

Perform the following steps to generate the SSC:

1. Download the SSC tool from EtherCAT.org website. An EtherCAT membership is necessary for down-
loading the code.

2. Install the SSC tool on the control or management PC.

3. Open the SSC tool and navigate to File>New to create a new project.

4. Select the “Custom” option, and then click Import. See Figure D-1.

FIGURE D-1: IMPORT THE CONFIGURATION FILE
 2021-2022 Microchip Technology Inc.and its subsidiaries DS50003106C-page 31
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5. Import the Microchip-LAN9255-SSC_Config.xml configuration file from 
<Harmony Directory>\ethercat\apps\ethercat_counter_foe_app\
firmware\src\slave_stack. After importing the configuration file, the Microchip SAM E53 
appears in the “Custom” field. Select it and click OK. See Figure D-2.

FIGURE D-2: CREATE A NEW PROJECT

6. Click Yes for the next two prompts.

7. Navigate to the <Harmony Directory>\ethercat\apps\ethercat_counter_
foe_app\firmware\src\config\lan9255_evb\driver\lan9255 directory to point to the 
drv_lan9255.c file and click Open. This loads the code.
DS50003106C-page 32  2021-2022 Microchip Technology Inc. and its subsidiaries
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8. Go to Tools>Application>Import Application. In the “Application name” field, enter sample_app, and 
click OK. See Figure D-3.

FIGURE D-3: IMPORT THE APPLICATION FILE
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9. Go to Tools>Create New Slave Files. When prompted to save the project, save it in the directory pro-
vided. Click the Start button to create the slave files (see Figure D-4).

10. When creation is complete, click the Open Folder button to open a window with all the slave files. 
See Figure D-4.

FIGURE D-4: CREATE NEW SLAVE FILES

11. Copy the files from the directory in the previous step (including the sample_app.c, sample_app.h, 
sample_appObject.h, and SAME53 EtherCAT Slave.xml files) and paste them to the 
<Harmony Directory>\ethercat\slave_stack directory.
DS50003106C-page 34  2021-2022 Microchip Technology Inc. and its subsidiaries
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